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Example — Plate with a hole
"l
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Objective: : ] _ )
Determine the maximum stress in the x-direction for E _ %1§OOON/mm
point A and display the deformation figure S

Tasks: a =200mm

How should this be modelled? b =100mm
Compare results with results obtained from norm t=10mm
calculations? r=210mm

- 2
Topics: o = 100N/mm

Element type, Real constants, modeling, mapped mesh,

plot results, output graphics, path operations
ANSYS Example0241
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Example - title

Utility Menu > File > Change Jobname e GUI
/jobname, Example0241 ¢ Command line entry
x| Enter: Example0241

[/FILM&M] Enter new jobname Ihle ° |

Mew log and error files? [~ Mo

Ok, | Cancel | Helpn |

Utility Menu > File > Change Title Enter: Plate with a hole
ftitle, Plate with a hole
x|
[/TITLE] Enter new title || °
0] Cancel Help
ANSYS Example0241 3
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Example — Areas Rectangle

Preprocessor > Modeling > Create > Areas > Rectangle > By Dimensions

Create an area given by X=(0,100) and Y=(0,50)

AMSYS Main Menu

'references
reprocessor
H Element Type
H Real Constants
H Material Props
1 Sections
3 rodeling
B Create
Keypoints
Lines
B Areas
Arbitrary
B Rectangle

Z By 2 Corners
# By Centr & Cornr

By Dimensions

Circle
Polygon
1 Area Fillet
Yolumes
Nodes
Elements
Contact Pair
Piping Models
Circuit
Racetrack Coil
Transducers
Dperate
Mowve / Modify
Copy
Reflect
Check Geom
Delete

Cyclic Sector
[ T

[

[RECTMG] Create Rectangle by Dirmensions
¥1,¥2 ¥-coordinates

1,%2 Y-coordinates

(]34 QJ Apply | Cancel |

[\ Create Rectangle by Dimensions _

Enter O or
leave empty

Enter 100

Help |

— Press OK

Note: Keypoints (4 kp’s) and lines
(4 lines) are automatically generated

(also numbered automatically)

Example0241

Cullipulauuvl ial wicenianics, AAU, Esbjerg

Enter O or
leave empty

Enter 50



Example — Areas Rectangle

il

AREAS

TY¥FE HUM

ANSYS Example0241
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Create an area given by (X,Y)=(0, 0) and Radius=10

Example — Areas Circle

Preprocessor > Modeling > Create > Areas > Circle > Solid Circle

ANSYS Main Menu

3|

Preferences
El Preprocessor

Element Type
Real Constants
faterial Props
Sections
H Modeling
Bl Create
Keypoints
Lines
B Areas
Arbitrary
Rectangle
B Circle
P
# Annulus
A1 Partial Annulu
#1 By End Points
By Dimensions

Polygon
#1 Area Fillet
Yolumes
Nodes
Elements
Contact Pair
Piping Models
Circuit
Racetrack Coil
Transducers
Operate
Wove / Modify
Copy
Reflect
Check Geom

—o-

« ' I_>Ij

a

Corﬁpljtational Mechanics, AAU, Esbjerg

li\solid Circular

¥ Pick " Unpick

x|

Up X

¥

Globhal X
¥
Z

Up X I

up ¥ I

Radius I

0K o

Apply |

Cancel |

|
Rezet I
Help I

Note: Keypoints (4 kp’s) and li
(4 lines) are automatically gen
(also numbered automatically)

Examp

nes
erated

le0241

Enter 10

Press OK



Example - Area

b s ANSYS

FEE 11 2004
10:07:232

ARELS

T¥PE NUM

ANSYS Example0241
Computational Mechanics, AAU, Esbjerg



b

Example - Operate

Preprocessor > Modeling > Operate > Booleans > Subtract > Areas
Create the final area by subtracting the circular area from the rectangular area

AMSYS Main Menu

®|

1 Preferences
| Preprocessor
Element Type
Real Constants
Ivlaterial Props
Sections
= Modeling
Create
B Operate
Extrude
Z Extend Line
E Booleans
Intersect
Add
Bl Subtract
A Yolumes
P eas!
& Lines
With Options
Divide
Glue
Overlap
Partition
Settings
Show Degeneracy
Scale
Calc Geom Items
Move / Modify
Copy
Reflect
Check Geom
Delete
Cyclic Sector
Genl plane strn
|-— X} . —

[ [+

-

=l

Subtract Area

% pick @ i ck

v Bingle i Box

Note: Bottom left corner of ANSYS GUI

| T45BA1 Pick or enter hase areas fram which to subtract

" Polygon {" Circle
- Loop

1]
e}

Count
Maximum

Minimum

Area No.

{* List of Items

[ Min, Max, Inc

Select the rectangular area and press OK

L Note: Bottom left corner of ANSYS GUI

| Pick ar enter areas to be subtracted

Select the circular area

0E @ Sk
Beset Cancel
Press OK
Pick All Help
Example0241 8

ics, AAU, Esbjerg



Example — Areas

g ANSYS

FEE 11 2004
10:17: 56

AREAS

TYFE NUM

ANSYS Example0241
Computational Mechanics, AAU, Esbjerg



ANSYS

Pan Zoom Fotate ...
Yiew Seftings

WorkPlane Parameters Macro MenuChrls  Help

Murnbering ...
Symbals ...
Style

Font Controls
Window Confrols
Erase Options

Animate
Annotation

Device Cptions ...
Redirect Plats
Hard Copy

Save Plot Cirls ...
Restore Plot Ctrls ...
Reset Plot Cirls

Capture Image ...
Restore Image ...
Wdrite Metafile

Mult-Plot Contrals ...

rAulE-W o Layout .

Best Quality Irmage

Computational Mechanics, AAU, Esbjerg

Example - Numbering

File Select List Plot PlotCirls

fiYPlot Numbering Controls

[/PHUM] Plot Bumbering Confrols

KF  Eeypaint numbers
LIME Line numbers
AREA  Area numbers
YOLU Walume numbers

NODE Mode numbers

Elem # atrib numbering
TABM Table Mames

Syl Mumeric contour values

il
[~ Off
I~ off
[~ Off —
I~ off
I~ Off

Mo numbering
I off

[ off

El

[T Bumbering shown with

ICDIDrS & numbers j

[/REPLOT] Replot upon Ok Adpph?

Ok, | Ay |

IRepIDt

Cancel |

El

Help |

Switch on Keypoint, Line, and Area Numbers —

Example0241
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Example - List Menu

File Select List Plot PlotCirls  WorkPlane Parameters Macro  MenuCirls  Help

Files +
Status 4
keypaoint 4
Lines ... °
Aress
Yolumes
Modes ...
Elements 4
Components
Farts i, ) ) )
e e — List Keypoint, Lines, and Areas
Properties ¥
Loads 4
Results +
Oither 4
ANSYS Example0241
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Example - Plot Menu

File Select List Plot PlotCirls  WorkPlane Parameters Macro  MenuCirls  Help

Replot |

Keyvpoints k keypoints
Lines o Hard Points
Areas

Yolumes

Specified Entities 4

MNodes
Elements
Layered Elements ...

e o Plot Keypoint, Lines, and Areas

Data Tables
Array Parameters L.,

Results +
mLlti-Plots
Components 4
Parts
ANSYS Example0241

Computational Mechanics, AAU, Esbjerg



Example — Element Type

Preprocessor > Element Type > Add/Edit/Delete

Element Types ) x|
l\Library of Element Types ]
Defined Element Types: n FEl i
NONE DEEINED ibrary ot Elerment Types SU’uct_Jra!I Mass (S
Lirk
Beam

Element type reference number

04 | Aoy | Cancel |

Quad 4node

42

drode 182

Shode 183

Shode

a2

Triangle tnode 2

X

Bnode 183

Help |

Add...e® Sptions- Betete Press Add
Clase | Help |
ANSYS Example0241

Computational Mechanics, AAU, Esbjerg




Example - Element Type

Preprocessor > Element Type > Add/Edit/Delete
x| Select Plane strs w/thk —
x|

Defined Element Types:

PLANELSZ Options for PLAMELE3, Element Type Ref, Mo, 1
Elerment behavior k3 Plane siress j
: Plane stress
Elerment output coordinates K4 Axisymmetric
Plane strain e
Element: formulation K& Flane strs withk @ =2
(MOTE: Mixed formulation is not valid with plane siress)
User defined initial stress K10 IN':' USTRES routmn j

Ok, | Cancel | Help @

Add... Options. .. |0 Balete Press Options
| |
_ckse | _teb_| Press Help to learn more about the |
element.
ANSYS Example0241 14
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Example — Real Constants

Preprocessor > Real Constants > Add
Real Constants

Defined Feal Constant Sets

MOME DEFIMED

X

Add... @

=1L
L | | R

trelete |

Close |

Help |

ANSYS

Element Type for Real Col

Choose element type:

Type 1 PLAMETS3

CF @

Cancel

Place the cursor
on the relevant
element and
press OK

Example0241

Computational Mechanics, AAU, Esbjerg
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Example - Real Constants

Preprocessor > Real Constants > Add

- Real Constants
li\Real Constant Set Number 1, for PLANE2 x|
' Defined Real Canstant Sets
Elerment Type Reference Mo, 1

Real Constant Set Mo, I h

Real Constant for Plane Stress with Thickness (KEYOPT (33=3)
Thickress THE I

® Ok | applky | Cancel | Help |

Enter 10

Edit... | Deleta |

Press Close
to finish

Press OK |

Heln |

ANSYS

Example0241 16
Computational Mechanics, AAU, Esbjerg



Example - Material Properties

Preprocessor > Material Props > Material Models
I\Define Material Model Behavior

wWaterial  Edit Help

— Material Models Defined

o]

Double Click
to step in the

— Material Models Available mate”al tree
& Material Model Nurmber 1 ] ﬁ Structural =]
@ Linear
8 Elastic
@ [sofropicll g
€ Orthotropic
@ anisotro [T, Isotropic Properties for Material N X|
Monlinear
© Density Linear Isofropic Material Properties for Material Murmber 1
Thermal Expansior
€ Damping -
| 8 Friction Coefficient
= ] | Temperatures I
femn | e BA=dmwri= ] Teie
‘ ILI_‘ | EX
PR
Add Temperature | Delete Temperature Graph
k. Cancel Help
ANSYS Example0241 17
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Example - Material Properties

Preprocessor > Material Props > Material Models

Click here
Linear Isotropic Properties for Material [ x| Enter 210000 |
Modulus of elasticity to Close
Linear Isotropic Material Properties for Material Mumber 1
Enter 0.3
S S Poisson’s ratio
Temperatures
EX
PRXY ] 0| x|
Material Edit Help
— Material Madels Defined — Material Madels Available
& Material Model Nurnber 1 izl @8 Structural =]
add Temperature | Delete Temperature | & Linear Isotropic &8 Linear
8 Elastic
® Ok | Cani
€ Orthotropic
& Anisofrapic
Monlinear |
& Density
Thermal Expansion Coef
# Darmping
PI’ESS OK - = @ Friction Coefficient
= (e | e B = im] Cumieane B
‘ Iﬂ_‘ J 2]
ANSYS Example0241

18
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Example - Meshing

Preprocessor > Meshing > Size Cntrls > ManualSize > Lines > Picked Lines

Element Size Element Sizes on Picked Lines X|

I o i [LESIZE] Element sizes on picked lines

SIFE Element edge length I
(o Single " Box I_

W el ey e MDY  Mo. of element divisions o
" Loop (MDIV is used only if SIZE is blank or zero)
KYNDIV SIZE,NDIV can be changed v Yes
Colt = 0
. . _ SPACE Spacing ratio I
Select/Pick meximam =1
; ndman = 4 ANGSIZ Division arc (degrees) I
LlneS tO Line MNo. = <
; ANGSIZ only if number of divisions (NDIV) and
Speci o
p hfy {* Lizt of Items element edge length (SIZE) are blank or zerao) See next page
mesn Size
f " Min, Max, Inc Clear attached areas and volumes [T Mo
or

Pick the two e —— oK | Apply | Cancel | Help |

longest lines

Beset Cancel

Pick &1l Help

Press OK when finish with selection

ANSYS Example0241 19
Computational Mechanics, AAU, Esbjerg




Example — Mesh Size

" Laues ANSYS
FEE 17 zZ004
25

LINE HUH 3 Element subdivisions R e

;l

6 Element subdivisions

i
L:'; 5 L9

5 Element subdivisions i

ANSYS Example0241 20
Computational Mechanics, AAU, Esbjerg




Example — Concatenate Lines

ARSYS Main Menu

Preferences
B Preprocessor
Element Type
Real Constants
Material Props
Sections
Modeling
E Meshing
Mesh Attributes
rMeshTool
Size Cntrls

Mesher Opts
=
|

A Lines
H Areas
Del Concats
resh
Modify Mesh
Check Mesh
Clear
Checking Ctrls
Numbering Ctrls
Archive Model
Coupling / Ceqn
FLOTRAN Set Up
FSI Set Up
Loads
Physics
Path Operations
Solution
General Postproc
TimeHist Postpro

@| [

1
LINES

! |2

ANDTO

Computational Mechanics, AAU, Esbjerg

— Press OK

% pick @ - LINE NUM
f* Zingle (" Box
(" Polygoli (" Cirele
(" Loop
Count = ul
Maximuam | = =
Minjimum | = z
Line Mo | =
(* List [of Items
(" Min, Max, Inc
@ LE Apply
Daset Cancal |
Hick &11 Help

Select L2 and L3 to create
a topologically foursided
geometry

Example0241 21



Example - Meshing

Preprocessor > Meshing > Mesh > Areas > Mapped > 3 or 4 sided
®| |
Select individual areas

AMNSYS Main Menu ANSYS Main Menu AMNSYS Main Menu

Preferences
E Preprocessor

Preferences
E Preprocessor

Preferences
B Preprocessor

Element Type Element Type Element Type _
Real Constants Real Constants Real Constants * pick@——tmpick to be meshed
Material Props Material Props Material Props
Sectiu_ns Sectiu_ns Sectiu_ns * Single e
Modeling Modeling Modeling
E Meshing B Meshing B Meshing " Tolygonm ¢ Cirele
Mesh Attribute: Mesh Attributes Mesh Attributes . )
MeshTool MeshTool MeshTool N B . It IS Often
Size Cntrls Size Cntrls Size Cntrls '
Mesher Opts Mesher Dpts Mesher Opts Count = 0 0 n
Concatenate Concatenate Concatenate Maximum = 1 necessary to Clear
B Mesh B Mesh 2 Mesh
# Keypoints A Keypoints A Keypoints Minimum = 1 the mOdel for
& Lines A Lines # Lines .
Area No. =
o 8 Areas 5 Areas el example if Element
Mapped =i B Mapped
2 Free #1 By Corners 21 By Corners Ol hen Gf Tetme Type or mOdeI
#1 Target Sur 213 or 4 sided P2
Volumes Concatenate Concatenate

Yolume Swee

Tet Mesh Fro

Interface Me:
Modify Mesh
Check Mesh
Clear

Del Concats
& Free
A Target Surf
Yolumes
Volume Sweep
Tet Mesh From

Del Concats

# Free

- Min, Max, Inc

A Target Surf ||

Yolumes
Yolume Sweep
Tet Mesh From

Computational Mechanics, AAU, Esbjerg

geometry is to be
changed

Select all areas defined
to be meshed

Checking Ctrls Interface Mesh Interface Mesh 0E Apply
Numbering Ctrls Modify Mesh Modify Mesh
Archive Model Check Mesh Check Mesh Deset CaaeD
Coupling / Ceqgn Clear Clear
FLOTRAN Set Up Checking Ctrls Checking Ctrls i
F5I Set Up Numbering Ctrls Numbering Ctrls Pl‘:k.‘a‘ll Help
Loads Archive Model Archive Model j
| | [ |+
ANSYS Example0241
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Example — Mapped Mesh

s ANSYS

i 17 2004
19:04: 54

LINE HTH

ANSYS Example0241
Computational Mechanics, AAU, Esbjerg
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Example — Analysis Type

Write Database Log l

Wiite D atabase Log to Directories:
i @ o hadminiztrator
Cancel |
= ot

| [=+ DOCUMEMNTS .&Nj Hel |
E= ADMINISTRATOI P
3 Cookies

3 Dokumenter

LI £ Foretrukne ﬂ
Solution > Analysis Type > New Analysis <t Al

IDatahase Log [ Igw] ;I I = ;I MHetwark. .. |
m New Ana I?ISis EI I'W'rite non-ezzential cmds as comments LI

[ANTYPE] Type of analysis

File > Write DB log file
Enter “example0241.lgw”

k

" Modal

" Harmonic

" Transient

" Spectrum

" Eigen Buckling
" Substructuring

oK | Cancel | Help |

ANSYS Example0241 24
Computational Mechanics, AAU, Esbjerg



Example — Define Loads

Solution > Define Loads > Apply > Structural > Displacement > On Lines

Select UY to fix the plate in the y-direction

% pick @& —mpick

I\ Apply U,ROT on Lines ' X|

¥ 2ingle { EBok Select the [OL] Apply Displacements (U,ROT) on Line
" Polygon  pibel . Lab2 DOFs to be constrained &l DOF
 Loop “==—— bottom straight
e o line
Maximuam = 4
Minimuam = 1
Line Mo. =
{¥ List of Items all DOF
- Min, Max, Inc
Apply as ICDnstant value j
YALUE  Displacement value I
0x @ pona) oK @ | dpphy | Cancel | Help |

Reset Cancel

Pick All Help
— Press OK
ANSYS Example0241 25
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Example — Define Loads

Solution > Define Loads > Apply > Structural > Displacement > On Lines

Apply U,ROT Select UX to fix the plate in the x-direction
e 28 e I Apply UROT on Lines ' x|
i Zingle { Eok Select the |eft [D;] Apply Displbacementa {U,:DT} on Lines

Polygon { fircle . . Labz DOFs to be constraine All DOF
e = | straight line
Count = 0]
Maximuam = 4
Minimuam = 1
Line Mo. =
{¥ List of Items all DOF
- in, Max, Inc
e Apply as ICDnstant valLe j
YALUE  Displacement value I
0x @ pona) oK @ | dpphy | Cancel | Help |
Reset Cancel
Pick All Help Press OK
ANSYS Example0241 26
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Example — Define Loads

Solution > Define Loads > Apply > Structural > Pressure > On lines

Apply PRES o

{* pich &——urp

ick

(o Single " Baoj

I\ Apply PRES on lines

[SFL] Apply PRES on lines as a ICunstant value

If Constant value then:

YALUE Load PRES walue I °®

If Constant value then:
Cptional PRES values at end 1 of line
{leave blank for uniform PRES
Yalue

= Select the
i Loop r|ght
I straight line
Maximuam = 5
Minimum = 1
Line No. = £ Enter '100
{* List of Items
- Min, Max, Inc
|
0E @ Zprpriyr
Reszet Cancel PreSS OK
Pick &1l Help to finish

Note: Pressure acts normal and

ANWERY to a surface _
Computational Mechanics, AAU, Esbjerg

————@ Ok | apply | Cancel | Help |

Example0241
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Example - Save

g ANSYS

FEE 11 Z004
10:45:29

AREAS
TYPE NUM

o

Display of Analysis model

AMSYS Toolhar

Save the model
SoavVE_DB | RESLIM_DB ‘ QUIT | POVYRGEPH ‘ E-CAE |

!

ANSYS Example0241 28
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Example - Solve

Solution > Solve > Current LS

ANSYS Main Menu @

Preferences

Preprocessor

B Solution
Analysis Type

pml o Solve Current LoadStep x
sty Opts Solve Current Load Step i x|

= rrE"t 5 o [SOLVE] Begin Solution of Current Load Step

From LS Files

Partial Solu Review the summary information in the lister window (entitled
Adaptive Mesh "/STATUS Command"), then press OK to start the solution.
FSI Set Up

ADAMS Connection
Unabridged Menu | e T
General Postproc Ok, Cancel Help
TimeHist Postpro

Topological Opt
ROM Tool
Design Opt
Prob Design
Radiation Opt
Run-Time Stats
Session Editor
Finish

HEREEEHEEBEA

Press OK

S Example0241
Computational Mechanics, AAU, Esbjerg




_ i ) Solution is done!

Example - Solve

Press Close

Press here
to Close
X|
File
SOLUTION OPTIODHS
PROBLEH DIHEMSIOMALITY. . & & v v @ & & & & = o« 2-0
[EGREES OF FREEDOH. . . . . . s Uy
AHALYSIS TYPE & v @ v v f v e e v e on e om s STHTIC [STEADY-STHTE]
LOAD STEP OPTIOHS
LOAD STEP HUHBER. . & v @ v & ¢ & &« & & o s = » 1
TIHE AT EMD OF THE LOAD STEP. . . . . . . . .. 1.0000
HUHBERE OF SUBSTEPS. & & @ v & ¢ & @ & & o s = » 1
STEP CHAWGE BOUMDARY COMDITIOMS . . . . . . . . HO
PRINT OUTPUT COMTROLS & &« v & v & @ & & o s = & HO PRINTOUT
DATABASE OUTPUT COMTROLS. . . . . . &« & o .« . . ALL DATA HRITTEM
FOR THE LAST SUBSTEF
ANSYS Example0241 30
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Example - PostProcessing

General Postproc > Plot Results > Deformed Shape

Plot Deformed Shape | x|

[FLDISF] Flot Deformed Shape
KUND  Items to be plotted

" Def + undeformed @

" Def + undef edge

oK | Apply Cancel | Help |

Select “Def+undeformed”
and Press OK

ANSYS Example0241 31
Computational Mechanics, AAU, Esbjerg



Example - PostProcessing

DISPLACEMENT

1

3TEP=1

— Read Maximum displacement: DMX

ANSYS Example0241
Computational Mechanics, AAU, Esbjerg
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Example — Contour Plot

General Postproc > Plot Results > Contour Plot > Nodal Sol

I Contour Nodal Solution Data X
[FLMNSOL] Cortour Modal Solution Data SeIeCt Stress

Item,Comp  Item to be contoured

2 drecton <z | Select SX for stresses in

W-shear  SXY

vZ-shear  5YZ = X'd|reCt|0n

KUND  Tterns to be plotted

& Def shape only

" Def + undeformed
" Def + undef edge

Fact Optional scale factor I 1

[/EFACET] Interpolation Modes

&+ Corner only
" Carner + midside

 all applicable

[AWPRIN] Eff MU for EQV strain |

CK, | Apply | Cancel | Help |

ANSYS Example0241 33
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Example — Contour Plot

1
NODAL 30LUTION
JTEF=1
JUBE =1

91.744 131.688 181,632 Z31.577

106.716 36.66 206,605

ANSYS Example0241
Computational Mechanics, AAU, Esbjerg
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Example — Select - Entities

File Select List Plot PlotCirls

Select Ent X|

Entities ...

Comp/assembly

Parts ..,

-

WiorkPlane Parameters

Macro  MenuChrls

Everything

Everything Below

-

ANSYS

INudt:s j

|By NumyPick ~|

* From Full
" Reselect

" Also Select

" Unselect

Sele All | Invert |
Sele Nunel Sele Eelul

—=e 0K | Apply |
Plot | Flf:plut|
Can[:t:l| Help |

Select nodes

{* pick @ ' THRpIcE

v Single {~ Box

" Polygon " Circle
[ Loop

&

Count

Maximuam 4z
Minjmum = 1

Node Mo. 10

{¥ List of Items

- Min, Max, Inc

0K Apply
Reset Cancel
Pick A1l Help

Example0241

Computational Mechanics, AAU, Esbjerg

See next page
for selection
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Example — Select Nodes

Select nod

{* pick " Tmpick

{* zingle {" Box

" Polygon (= Circle
~

Count = &
Maximuam = d 7
Minimuam = 1 Select the
e indicated
{* Lizt of Items nOdeS
(" Min, Max, Inc
Note: the
5 = o select!on
Beset Cancel Order IS
o s Important —
[ i start from the
, | | : hole
31.799 81.744
56e.771 106.716
ANSYS—- Enter OK when finished Example0241 36
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Example — List Results

ANSYS Main Menu @
S E— AIllfAYList Nodal Solution X|
PREPTOCESSON [FRMSOL] List Modal Solution
Solution :
B General Postproc Item,Comp  Item to be listed DOF solution Components SCOMP
Data & File Dpts —@ Principals SPRIN

Strain-total
Strain-rmech+thrm e
Manlinear iterms

Results Summary
Read Results
Failure Criteria
Plot Results Il |

L Strain-elastic
& Slggtisiluelslsﬁummar! Sliar e ol ;I companents S-OMP

Iteration Summry [&%PRIN] Eff MU for EQY strain |

Percent Error
Sorted Listing
Element Solution ® Ok | Apply | Cancel | Help |

Section Solution
Superelem DOF

Reaction Solu
Nodal Loads
Elem Table Data
vector Data
Path Items
Linearized Strs

] I
el Select Stress, SCOMP

Results Yiewer
Write PGR File
mModal Calcs
Element Table

Path Dperations — Press OK
Load Case j
[ |
ANSYS Example0241 37
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Example — List Results

RPRNSOL  Command x|
File
PRINT &  HODAL SOLUTIOH PER HODE
#eik POST1 HODAL STRESS LISTING seteteter
Pouerbraphics Iz Cuvrent 1y Enabled
LOAD 5TEP= 1 SIBSTEP= 1
TIHE=  1.0000 LOAD CASE= O
HODAL EESULTS ARE FOR HATERIAL 1
THE FOLLOHIWG ¥,%,Z MALUES ARE IM GLOBAL COORDIMATES
HODE 5% a BTl sy ST SnE
0 10361 1.6296 0.0000 3.4444 0.0000 0.0000
13 256.55 5.3 0.0000 -12.718 0.0000 0.0000
14 107.%1 4.2797 0.0000 4.9680 0.0000 0.0000
15 110.83 10.580 0.0000 74088 0.0000 0.0000
16 116,35 18,912 0.0000 gL 0.0000 0.0000
17 129,59 26,013 0.0000 4,240 0.0000 0.0000
HINIHUA MALUES
HODE 0 0 0 13 0 0
YALUE  103.81 1.6296 0.0000 -12.714 0.0000 0.0000
HAXIHUA YALUES
HODE 13 13 0 1h 0 0
YALUE  25a.55 5.3 0.0000 a2ree 0.0000 0.0000
ANSYS Example0241 38
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ANSYS

Replot

Keypoints

Lines

Areas

Yolumes
Specified Entities

k

Example - Plot - Nodes

File Select List Plot PlotCirls  WorkPlane Parameters Macro  MenuCirls  Help

Keypoints
Hard Points

Modez @
Elements

Layered Elements ...

Materials
Data Tables

Array Parameters L.,

Results
multi-Plots
Components
Farts

Computational Mechanics, AAU, Esbjerg

Plot Nodes

Only 6 FE nodes are displayed
— the same nodes as selected
previously

Example0241 39



Example — Select - Entities

File Select List Plot PlotCirls

Entities ...
Comp/assembly
Parts ...

-

WiorkPlane Parameters

Everything
Everything Below

-

ANSYS

f\select Ent X|
INudt:s j

|By NumyPick ~|

* From Full
" Reselect

" Also Select

" Unselect

Sele All | Invert |
Sele Nunel Sele Eelul

—=e 0K | Apply |
Plot | Flf:plut|
Can[:t:l| Help |

Macro MenuCtrls Help
Select nodes
{* pick - Tnpick
v Single {~ Box
" Polygon " Circle
[ Loop
Count = =
Maximum = 4z
Minjmum = 1
Node Mo. = 10 |
Select Pick All

{¥ List of Items

- Min, Max, Inc

(1].4

Apply

Reset

Cancel

Pick All*—Hrl-p—

Example0241

Computational Mechanics, AAU, Esbjerg
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Example - Plot - Nodes

File Select List Plot PlotCirls  WorkPlane Parameters Macro  MenuCirls  Help

Replot |

Keyvpoints k keypoints
Lines Hard Paints

Areas

Yolumes Plot Nodes
Specified Entities 4

Modes @
Elements
Layered Elements ...

Materials
Data Tables
Array Parameters L.,

Results +
mLlti-Plots
Components 4
Parts
ANSYS Example0241

Computational Mechanics, AAU, Esbjerg
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Example - Plot - Nodes

ANSYS

FEE 17 2004
20:39:53

ANSYS
Computational Mechanics, AAU, Esbjerg

Example0241




AMNSYS Main Menl

Preferences

Preprocessor

Solution

B General Postproc
Data & File Opts
Results Summary
Read Results
Failure Criteria
Plot Results
List Results
Query Results
Options for Outp
Results Viewer
Write PGR File
MNodal Calcs
Element Table
B Path Operations

.

# By Nodes e

On Working Pla

By Location

Path Status

Modify Path

Path Dptions
Delete Path
Plot Paths
Recall Path
Map onto Path
Plot Path Item
Linearized Strs
List Linearized
Add

| | B

By Nodes

E>|<ample — Define Path

* rick @ - LBy Wi 4

oy Zingle {0 Box

€ olygon {0 Cirole
i Lioap

n
o}

Count

Maximam 4 F

n
=)

Minimum

Node Ho. =

{* List of Items

(" Min, Max, Inc

ANDT O

Computational Mechanics, AAU, Esbjerg

O Lpply
Baset Cancel
Eaiaaeniil Help
Example0241

See next page for selection
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Example Define Path - By Nodes

{* pick (" Unpick

g 5
r o
~

I
[}

Count
Maximuam

Minimuam

[} [} ]
]

Node Mo.

{* List of Items

(" Min, Max, Inc

81,744
56.771 106.716

ANSY¥s— Enter OK when finished Example0241
Computational Mechanics, AAU, Esbjerg

Select the
indicated
nodes

Note: the

selection

order is
important —
start from the
hole
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Example — Define Path - By Nodes

[A\By Nodes ]

[FATH] Cefine Path specifications

Mame Define Path Mame :

nSets  Mumber of data sets

Jil}.

nDiv  Mumber of divisions

— Enter an appropiate name, e.g. SX

0]4 OJ Cancel | Help |

Enter OK

ANSYS Example0241 45
Computational Mechanics, AAU, Esbjerg



Example — Map onto

AMSYS Main Mernu

Preferences
Preprocessor
Solution
E General Postproc
Data & File Opts
Results Summary
Read Results
Failure Criteria
Plot Results
List Results
OQuery Results
Options for Dutp
Results Viewer
Write PGR File
Modal Calcs
Element Table
E Path Operations
E Define Path
& By Nodes

By Location
Path Status
Modify Path

Delete Path
Plot Paths
Recall Path

Plot Path Item
Linearized Strs

List Linearized
Add

On Working Pla

Path Options

lap onto PathK S

Hil i

®| Fi\Map Result Items onto Path

[FCEF] Map Result Items onto Path
Lab User label for item

Item,Camp Item to be mapped

[A%PRIN] Eff NU for EQY sirain

DOF solution

Strain-total
Energy
Strain-elastic
Strain-thermal
Strain-plastic

H-direction SX

Y-direction Sy
Z-direction 52
¥y-ghear  SXY
YZ-shear  SYZ

ot

H-direction S

Average results across element v yes
[[/FBC] Show boundary condition symbal
Show path an display [~ Mo

OK .J Apply |

Cancel |

Help |

- Press OK

Example0241

(.;UIII[JULGLIUI 1al viculianniCs, AAU, Esbjerg

Select Stress, SX
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Example — Plot Path on Graph

ANSYS Main Menu @

= Preferences &

4 Preprocessor
7 gu|£tiun Fi\Plot of Path Items on Graph Ed|

3 General Postproc [FLPATH] Path Plot on Graph

Data & File Opts . —
Results Summary Labl-6 Path items to be graphed A

Read Results Ml
Failure Criteria e
Plot Results 5
List Results St | @
Query Results
Options for Outp
Results Viewer
Write PGR File
Modal Calcs
Element Table
B Path Operations
Define Path
Delete Path
Plot Paths SeIeCt SX
Recall Path
Map onto Path
Bl Plot Path Item
On Graphjik
On Geometry — Press OK
List Path Items
Path Range
Linearized Strs
List Linearized
Add
Multiply
Divide |
R [+
ANDT O Example0241
Computational Mechanics, AAU, Esbjerg

® K Apply Cancel Help




Example — Plot Path on Graph

g PO3TL ANSYS

FEE 17 2004
19:42:04

STEFP=1
5UE =1
TIME=1
PaTH PLOT
NOD1=13
NOD==10

ANSYS Example0241
Computational Mechanics, AAU, Esbjerg
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Example — Comments/Questions

 Change the element type to a second
order element type and rerun?

 The “example0241.lgw” can be edited In
“Notepad”

 Will the shape or the number of elements
affect the solution?

e Determine the shear stress In the lines of
symmetry?

ANSYS Example0241
Computational Mechanics, AAU, Esbjerg
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File menu

File Select List Plot PlotCirls \WorkPlane Parameters Macro MenuCirls  Help

Clear & Start Mew ... —
Change Jobname ... You can include commands to be
Change Directory ... executed when the program starts up in ——
izh Title ... .
e the start71.ans file.
BESTE dotaaine al li\Clear Database and Start New
Resume fram ...
Save as Jobname.db [/CLEAR] Clear database and start nemw!
Save as .. Bec stark s gl Lo L
Write DB log file ... @ Read file
" Do not read file
Read Input from ...
Switch Cutput to »
List * x| _ cancel | e |
File Operations 4
dilseile e Clears (zeros out) the database stored in
Impart : memory. Clearing the database has the same
Bt effect as leaving and reentering the ANSYS
Repart Generatar .. program, but does not require you to exit.
/  Exit.. Example0241

Computational Mechanics, AAU, Esbjerg
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